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Welcome

Thank you for using Friendess CypCutE laser cutting control software!
"Friendess CypCutE Laser Cutting Control Software" (hereinafter referred to as

CypCutE) is a set of software tools for planar laser cutting, dealing with laser cutting
techniques, simple nesting features and laser cutting control. The main functions
include graphics processing, parameters setting, custom cutting process editing,
nesting, cutting path planning, simulation, and cutting control.

CypCutE software must be used with dongle and control card in order to carry
out machining control.

CypCutE will enter demo mode when running on a computer without a dongle,
and you can use all functions except machining control. Therefore, CypCutE can be
installed on a laptop for pre-machining design.

Please note that this user manual is only used as an operation instruction for the
main program of CypCutE software. Please refer to other manuals or contact us
directly for other program installed with CypCutE, including configuration tools.

This document is based on CypCutE version 7. 1.2210. Due to the continuous
updating of software functions, the CypCutE software you use may differ from the
statements in this manual in some aspects.

If you have any questions or suggestions in usage of our products, please feel
free to contact us!
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The working and cutting performance of the machine are
directly related to the material, laser, cutting gas, gas
pressure and the parameters setup. Please be cautious in
setting the parameters!

Improper parameter setting and operation may reduce the
cutting performance, damage machine components and
even human body. CypCutE system has already provided
multiple protections, meanwhile manufactures and users
must follow the safety operation rules in case of any
accidents and injuries.
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1. Quick Start

1.1Features
Support AI, DXF, PLT, Gerber, LXD file format, and standard G code created by

Master Cam, Type3, ARTCUT etc.

Support file optimization includes: remove duplicates, connect unclosed segments,

remove minimal graphic and distinguish inner and outer contour and set machining

sequence automatically. Above functions can be customized or executed manually.

Support common editing and typesetting functions, including scaling, translation,

mirroring, rotation, alignment, copying, combination and so on.

Support setting lead line, kerf compensation, micro-joint, bridge, inner/outer cut, seal

etc.

Automatically distinguish the inner and outer contour to determine the compensation

direction, and check the lead line.

Support curve splitting, merging, and smoothing, text to curve, part combination and

explode etc.

Time-saving and labor-saving automatic nesting function can generate co-edges and

remnant.

Plates can be easily filled by various array modes.

Flexible automatic and manual sorting functions. Users can group the graphics to lock

the cutting sequence.

Preview the cutting sequence.

Quick set fly cut path.

Support various piercing methods including segmented pierce, incremental pierce,

pre-pierce, group pre-pierce. Users can also set separate parameters of pierce and

cutting including laser power, frequency, gas, pressure, peak power, delay, cut height

etc.

Real-time frequency and power curve editing. Set slow start parameters.

Powerful material library function allows all process parameters to be saved for reuse

of the same material.

Breakpoint memory when machining interrupted. And users can select resume

position before or after breakpoint. Only machining selected graphic supportable.

Users can locate to specified position in stop or pause status and resume machining.

Support round tube and plane sheet cutting; Support intersected line cutting.
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Support cutting at fixed height and laser head follows in from outside plate1.

Support various find-edge methods with high precision.

Powerful expansion capacity with more than 30 PLC, over 50 programmable

processes.2

Support programmable input and output port, and alarm input.

Support remote control of the system through wireless keyboard and Ethernet3.

1.2Acquiring, Upgrading and Installing Software
You can contact the supplier or customer service staff to obtain the software, or

directly download from Friendess official website www.fscut.com.
Before installing, check that your system meets the following configuration

requirements:
Win7 and above operating systems.

CPUI3 and above.

At least 4GB memory.

VGA display over 15 inches, resolution over 1920*1080, 32-bit true color display is

recommended.

At least 2 USB ports.

If you are using an operating system based on Vista(including Windows Vista,

Windows 7, Windows 8, Windows 2008 Server), to avoid possible errors, try to run as

administrator.

After checking the running environment, you can install and run the software
directly. It"s required to run as administrator under Vista-based operating systems.

To avoid program files modified during installation and ensure all drivers
installed properly, please close anti-virus software like 360 security guards.
Notice: 360 security guard cannot ensure that there is no virus on the computer. If the
computer has been infected by the virus, and 360 security guard is running, it may
prompt CypCutE to be a virus, which may cause CypCutE cannot work properly.

1This function requires BCS100 controller.
2This function requires trained professionals and password credential given by manufacture.
3Necessary hardware required.
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1.3Start Operation

1.3. 1 Desktop Shortcuts

After installation, the icon will appear on the desktop. Double-click

to run the CypCutE laser cutting control software.

1.3. 2 User Interface

The center zone in black is drawing board, the white frame is the machine
working area. The grid of drawing board and ruler will adjust when zoom the view.

On the main screen from top to bottom is title bar, menu bar and tool bar. You
can find most commonly used functions in tool bar where the function button
group-displayed with clear icons. The menu bar includes "File"" menu and other 5
tool menus "Home", "Draw", "Nest", "CNC" and "View". Click the menu will display
the related tool bar. At top left is "Quick Access Bar", which is used to create, open
and save files. Also undo and redo the operation.

On left side is "Drawing Tool Bar"; the basic drawing functions are provided
here. The first five buttons are used to switch the drawing mode, selection, node
editing, and sequence editing, dragging and zooming. Other buttons below
correspond to the graphic, click to insert new graphic on drawing board. There are
three keyboard shortcuts at the bottom, which are align center, explode graphic and
add fillet.

On the right side is the "Technique Tool Bar" including 1 "layer" button and
other 19 buttons of different layer color. Click "Layer" button will open "Cutting
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Technique" window where users can set most of the parameters related with material
cutting; 15 buttons each corresponds with a layer, click a button will appoint a layer
to selected graphic. If no graphics selected, click layer color button next time you
drawing a graphic will use it as default layer. The "X" button can set the graphic to a
non-machined layer, and the "√" buttons can re-set the non-machined layer to a
machined layer. The white button represents the "background layer", and the last two
layers are the first and last processed layers respectively.

There are three scrolling text ribbon windows at bottom. On the "Draw" window
will display all information related with drawing command; On the "System" window
will display all system information except drawing, each message printed with time
line and marked with different colors so users can recognize these messages as error,
alarm or notice etc. On the "Alarm" window displays all alarm messages of red color.

At the bottom is "Status" bar showing message according different operation.
The left status bar shows graphic message, on the right side displays cursor position,
machining status, laser head position. The rightmost is to fine tune the graphic
position with arrow keys, and display control card type.

On the right area of the main page is "Control panel", where users execute most
commonly used machining operations. From top to bottom are coordinate system
selection, manual control button, machining control, process setting and production
counting.

1.3. 3 Toolbar

CypCutE tool bar displays as Ribbon style that partitions function buttons. The
figure below will help you understand:

The tool bar is divided into five sub-menu "Home", "Draw", "Nest", "CNC",
"View". Click sub-menu title will switch to the related page; in machining process
will show "Working" page and cannot switch to other page until process stops.

In each sub-menu there are function buttons divided into different region; the
first button in each sub-menu usually in large size for direct operation; The triangle
under function button is drop-down menu provides more operation options. Click the
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icon and in the drop-down menu will display different dialog boxes with different
options. Click " " will open a dialog box.

If you have used Office 2007, Windows 7, or other Ribbon-style programs
before, you are probably already familiar with this arrangement. It does not matter
even if you use it for the first time. We believe you will like it.

1.3. 4 File Menu

In the upper left corner of the tool bar is "File Menu", which contains options

related with file operation. Click " " to open the menu, as shown below:
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Notice that the recently opened files are listed on the right column, where the

file saved by CypCutE comes with a " "Icon, this is for you to conveniently find

the files that have been designed last time.
"History File" in the menu allows you to browse thumbnails of recently opened

files, making it easy to quickly find and open files.
Click "save as" in the menu, you can choose to save the file in lxds or dxf

format.
Add file from "File-Import" will not clear the existing graphics on the drawing

board. If you just want to open an external file, just click "File-Open".
By "File-Report" users can export the processing report, nesting report and

production report.
The "User Setting" is used to set some parameters to fit user habits.
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The "Backup" is used to back up all parameters to a compressed file for easy
recovery.

The "Save Troubleshoot File" is used to back up abnormal situations to facilitate
problem troubleshooting.

Click "Diagnostic Tools" can open axis monitor, IO monitor and BCS100E
monitor, which are used to monitor the status of equipment and facilitate the
troubleshooting of problems.

Click "About" in the lower right corner to see the detailed version information of
CypCutE software.

1.4Operation Process

1.4. 1 Importing Files

Click " " button in the upper left corner of the interface to open file. Preview

window of open file dialog box will help you quickly locate the file you need.
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You can also draw figures with CypCutE software, click button " ", and then

use functions at left toolbar. See the relevant section for details.

1.4. 2 Preprocessing

While importing graphics, CypCutE automatically removes minimal graphics
and duplicate lines, merges unclosed lines, automatic smoothing and sorting.
Generally, you can start to set cutting parameters without other operations. If the
automatic processing cannot meet your requirements, you can open the menu "file" -
"user setting" to set the function options you need.

Generally, the software considers that all the graphics to be processed should be
closed lines. If you open a file containing non-closed graphics, the software may
prompt you message and display them in red color. But this function may be turned

off. To view the unclosed graphics on the drawing board, you can click " " and

" " under "View" button in Home menu to highlight the unclosed graphics; you can

also select unclosed graphics by clicking "Select" and choose "Select Open Figure".

If you need to split graphics manually, click " " under "Optimize"

drop down menu and click graphic where you want to split. To merge graphics, select

the graphics you want to merge, and then click " " under "Optimize"

drop down menu.

1.4. 3 Cutting Technique

You may use most of the functions under "Technical Setting" column in the
Home menu bar, including setting lead lines and compensation, etc. The Large button

" " can be used to set lead lines, buttons " " used to set over-cut,

gap, seal, or multi-Cut parameters; button " " for compensation; button

" " used to insert uncut microjoints in graphics; button" "

you can reverse the machining direction of a single figure selected; button

" " used to set cooling points. Click " " button, then point
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on the graphic where you want the cutting to start at will set a start point. If you point
outside graphic then point to the graphic will set a lead line.

You can press Ctrl+A select all graphic, click "Lead" set parameters then
program will set lead line on graphics automatically. Click "Lead" drop-down menu
select "Check Leadline", program will check if lead line cross with graphic or in
wrong direction and get them optimized.

On the right toolbar, click the " " button, you can set detailed cutting
parameters. The "Layer Parameter Settings" dialog box contains almost all the
parameters related to the cutting performance.

1.4. 4 Cutting path planning

Set the cutting sequence of graphic as needed. Click " " in Home or Nest

column will automatically set the cutting sequence of all graphic. Open drop-down
menu you can choose sorting pattern, decide whether to allow automatically sorting
changing machining direction, and recognize inner and outer contour of the parts
graphic.

If automatic sorting does not meet the requirements, you can click " " button

to enter the manual sorting mode, click the graphics with the mouse in turn to set the
processing order. Or press and hold the mouse to draw a line from one graphic to the
other, and you can specify the order between the two diagrams.

Select several graphics that have been sorted (set sequence), and then click

under the Home or Nest bar Group " " button to fix their order. After that,

neither automatic sorting nor manual sorting will change the sequences inside the
group, and the group will always be a whole.

Right click a group and select Group Sort you can modify the sequence of the
graphics within a group.

1.4. 5 Pre-cutting Check

Check the machining track before cutting,. Drag the Progress Bar to quickly
view the graphics processing order, click interactive preview buttons you can view
the graphics processing order one by one.
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Click " " on the console can simulate processing, through simulate

speed function on the " " page allows you to adjust the simulation speed.

1.4. 6 Start Cutting

Please note that it requires compatible control card and dongle to actually realize
machining.

Before start processing, you have to match the position of graphic and machine

bed. Click " " button on the left side of the control panel will show the

corresponding position of graphic on the screen and machine bed. This position is
calculated by the reference mark location on the screen and the laser head position at
machine. There are some symbols on the screen, click "Preview" the "Reference"
mark will move to the laser head position.

If the Red Cross does not match the real position of laser head, please check the
mechanic origin and correct the origin by CNC-Return origin. If click "Preview" and
graphic is partly or fully outside the white frame, it means machine will exceed the
travel range.

Click " " in Home menu can modify the reference position of the

graphic. For example, if laser head is at left bottom of the graphic then set the
reference as left bottom.
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After checking the position, click " on control panel, laser head will
move along the rectangular frame of the graphic, you can check if the machining area
on machine bed is right. Click "Generate Border" drop-down menu in Home and then

click " " to check position of parts with irregular remnant contour. You

can click " " to further check by making cutter travel along the whole
cutting path with laser off.

Finally click " " to start processing. Click " " pause
processing, in pause status you can manual control laser head up and down, open or

close laser and gas, click " " to move forward or backward

along the graphic path. Click " " to resume processing; Click

" " fast start cutting without piercing.

Click " " to stop processing. Laser head will return to the pre-set
position. If you didn"t change graphic or start new machining process, click

" " will locate to the break position where last machining was end and

click " " will start processing from breakpoint.
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2. Graphic Edit

2.1 Graphic Display
In Home menu -"View" column provides various options of graphic display.

Click the button in the above picture, and the display will take effect
immediately. You can see the change of the display in the drawing board. When the
option button in dark gray, it is enabled, otherwise, it is not. For example, the on state

" ", the drawing board with arrows to show the graphics processing path, closed

state" ", the arrow on the graph disappears.

When "Display Micro Joint Tag" is turned on, you can clearly see the position of
the micro joints (white rectangular mark) on the graph, as shown in the following
figure:

When the graphic is selected, click " ", the selected graphics will be

displayed in the center of the white frame, and if you click directly without selecting
any graphics, the overall graphics will be displayed in the center.



18/74 Friendess CypCutE Laser Cutting Control Software

Click " " in the lower right corner of "View", you can open a dialog box for
more detailed control over the drawing board, including Auto Attach, Display ruler
on and off, change Pick Precision etc.

Scroll the mouse on the screen will zoom the view. Click F3 will center all
graphic on the screen, click F4 will center the machine frame on the screen. Right
click mouse will prompt option box, select zoom you can also execute same
operations above.

2.2 Selection
CypCutE provides various ways to select graphics. The basic operation is

"Click", click the graphic will select it. Another commonly used operation is
"Frame", drag the cursor on the screen will create a frame box. There are 2 patterns
of "Frame": Press and hold from left to right will create a blue box, only when a
whole part was framed in the box will be selected. From right to left will create a
green box, as long as part of the graphic was framed in the box, the whole graphic
will be selected.

The "frame" effect of these 2 patterns are shown below. Left image is effect
framing from left to right, "BC" will be selected; right image is effect framing from
right to left, "ABCD" all selected. It"s flexible to select graphic by these two patterns.

Press Shift when select graphic you can select or deselect graphic without
changing the select result of other graphics.

Click "Select" will open a drop-down menu providing advanced options:

Basic operations: Select all (Ctrl + A), invert selection, copy (Ctrl + C), paste (Ctrl +

V), cut (Ctrl + X), delete, deselect (click on the blank area), copy with base point

(select a point, the relative position between graphics and mouse is the same as that

between base point and original graphics when pasting).

Graphic operations: select open figure, select similar figure, select all outer or inner

contours, select graphics smaller than specified size (enter the size in the drawing

information bar at the bottom of the interface).

Layer operation: Select a layer (used to select all graphics in a layer) and lock the

background.

"Disable Fast Drag-Copy" will disable the operation that press Ctrl and drag the

graphics to duplicate graphics. This will prevent the malposition of nested graphics.
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"Select similar figure" allows you to select all shapes of the same size on the
drawing board, for example, select a 5mm circle first, and then click this option to
select all 5mm circles.

2.3 Geometric Transformation
"Geometry-Transform" under Home page provides abundant functions of

transforming geometry including flip, rotate, align and zoom etc.

2.3. 1 Size Modification

CypCutE provides 11 options under "Scale" drop down menu to quick modify

the graphic size. As shown on the right:
For example, "100mm" scales the graphic to a width of 100mm, and "2 times"

scales it twice.
If you want to input an accurate dimension, click Scale button will prompt the

below dialog box. Input new size and click OK to finish the size modification.
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When the state of the lock is , the length and width are locked according to

the size ratio of the original drawing. If you want to modify the length and width

separately, click " " to unlock, and the button becomes" ".

"Scale Center" can specify the position between the new graphic and the original
one. For example, selecting "Top Left" indicate the graph in new scale at the top left
of the original one.

Notice: The lead lines and seam compensation etc., will not change with the
size modification.

2.3. 2 Dynamic Transformation

CypCutE provides 3 patterns of dynamic transform including zooming, rotate
and flip. First select the graphic and click transform button then follow operation tips
at screen bottom.

For example, a rectangle, rotated 45 degrees based on its lower left corner, can
be done as follows:

1) First, select the rectangle.

2) Then click the small triangle below "Transform" to open the drop-down menu, select

"Rotate", and it will prompt "Please specify base point:" at the bottom of the screen.

3) Move cursor to the left corner, cursor will absorbed to the rectangle corner automatically,

as shown in the following figure:
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4) Click the corner, bottom window will prompt "Please specify the start point or rotation

angle"

5) Input 45 and click Enter will finish the operation.

If you want to rotate the rectangle and align with another graphic, first step same
with above, then follow the below steps:

6) Click the right corner of rectangle will create a base line.

7) Bottom window prompts" Please specify end point of rotation" meanwhile move cursor

graphic will rotate and click mouse at target position. As shown below:

Zoom and Flip operations are the same with the rotate.

2.3. 3 Fast Translation and Copying

CypCutE software supports quickly translate graphics with arrow keys. First,

click the "Fine Tune" button in the lower right corner of

the interface to enable the function , then the number box

on the right can be edited. Select a graphic and click the direction button, it will move
at this direction and in fine tune distance. This function is used to move away a
graphic temporarily and move it back exactly where it was. Press Ctrl button and
direction key in the same time will duplicate the graphic. For example, press
"Ctrl+right" buttons will duplicate the selected graphic at the 100mm right side of
the original one.
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2.4 Coordinate and Parameter Input
In some cases, we want to draw in precise coordinates. CypCutE allows you to

enter coordinates directly. The format of coordinate input is < X coordinate > <
English comma, > < Y coordinate >, for example, enter coordinates (100, 100) and
enter "100, 100". The entered coordinates and parameters are displayed in blue.

Most of the drawing operations allow both mouse-click position and coordinate
input. The following steps show you how to draw a rounded rectangle of length
300mm, width 200, fillet radius 50mm.

1) Click " " button at left toolbar, meanwhile bottom window

will prompt "Please specify start point".
2) Input "0, 0" and press enter, then prompt "please specify cross point".
3) Input "300,200" press enter, prompt "please specify radius or [chamfer (F)]:"
4) Input 50 press enter. All operations completed. As shown below.

2.5 Automatic Attach
CypCutE provides automatic attach function, including attach to grid, key points

of graph, boundary of graph and etc,.

You can disable the auto-attach function by clicking " , select User

Setting, find the Drawing in the dialog box, and uncheck the " ". The

precision of automatic adsorption is also set in the above dialog box.

2.6 Graphic Drawing
CypCutE provides graphic drawing function. On the left toolbar from top to

bottom is: Isolated point, straight line, poly line, circle, arc, rectangle, polygon, text,
standard parts. The first 5 functions are standard drawing functions similar with
those in CAD.
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2.6. 1 Standard Graphic Drawing

Drawing isolated point, line, poly line, circle, rectangle are easy to operate, and
will not be detailed here. There are two options under Draw - Circle drop down
menu, "Replace Circle with Point" and "Replace Selected with Circle". The two
functions can replace a circle with an isolated point or replace a graphic with a
circle, so as to facilitate flycutting.

In Polygon drop down menu there are rectangle, rounded rectangle, polygon and
star shape. To draw a rounded rectangle you have to draw a rectangle first, then
specify the fillet radius by moving cursor or directly input fillet radius in bottom
window; To draw a polygon or star shape, you have to specify the number of edges
(from 3 to 100); The number of edges for star shape equals to the point angle number.
Besides, in Draw menu, under Rectangle drop down menu, there is Obround shape
option, draw a rectangle first, and then add a semicircle to both ends of the it.

2.6. 2 Text Input

In CypCutE users can input Text and transfer text into curves. Click the , in

left toolbar and point at screen to insert text. Text are selected as they are input.
Select text there will be a "Text" column at the top toolbar, users can modify the

text, type and size etc., as shown below:

Please take notice that after turning text into curve, above functions will not be
available. You would better finish all design and settings of the text before turning it
into curve.

2.6. 3 Standard Parts

CypCutE provides standard parts library. On the left drawing toolbar, click " "

you can draw commonly used parts. Select the part shape then set the parameters as
shown below:
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2.7 Graphic Optimization
CypCutE will automatically optimize the graphics when importing external

graphics. Under Home- Optimize drop down menu users can manually select
optimize options.

Select the graphics, click the corresponding buttons, and then follow the hint
finish the operation.

2.7. 1 Smooth Line

Select the polylines need to be optimized then click " ", the

dialog box prompts for inputting smoothing precision, input and click to take effect.
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The smooth result is shown below. In order to observe the effect conveniently,
the value input here is large. Users can set the smooth precision as needed.

2.7. 2 Break Line

This function is to break the closed curve graphic into separate graphic for

editing. Click " " at the split position. The split function will be

activated until press ESC to disable the function or switch to other command.

2.7. 3 Delete Duplicate

This function is used to remove all the overlapped line on the closed contour.

2.7. 4 Delete Invisible

Sometimes the imported files may contain graphics that visually imperceptible, resulting in

an abnormal position in machining. This function enable users to remove these minimal graphics

after setting parameters to define their dimension range. Graphics smaller than the
range will be removed.

2.7. 5 Join Line

The graphic created by AutoCAD might be visually closed contour but actually
not. Users can use this function to combine unclosed contour. Select the unclosed

contour and click " ", enter the join precision to take effect.

Please take notice that there might be excess line at geometry end, split and
remove the excess line then combine the contour.
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2.7. 6 Break Grid

This function is to add cut lines at in part holes to prevent tip-up collision. Cut
lines are displayed in white to distinguish part graphic.

2.8 View
Users can zoom, display, and edit graphics, adjust graphic position and sequence

in view module. It can be found on the left of the toolbar or and the last item "View"
in the menu bar. In the "View", you can make custom choices on system language,
shortcut bar options, unit selection, etc.
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3. Graphic Technique and Tools
This chapter introduces the cutting techniques related functions provided by

CypCutE. Users need to set the parameter according the material, laser, gas etc.,
which are directly involved in the cutting technique. All parameters here should be
considered as reference not a guide value.

Warning! Improper or wrong parameters may lead to poor cutting
performance and even damage the machine tool, please set it carefully.

3.1 Lead Line

3.1. 1 Distinguish Inner and Outer Contour

CypCutE will distinguish the inner and outer contour automatically when import
external file like DXF. Inner and outer contour will reverse in graphic editing. If you
need to distinguish inner and outer contour again, click the "Sort" button, in drop
down menu there is "identify inner/outer contour"; or find it in "Lead" drop down
menu.

CypCutE distinguish the inner and outer contour by the boundary relations. It
will define the outmost contour as outer contour, the second is the inner contour, the
next outer contour again, and unclosed graphic will not be defined as a contour. If
you want to set one contour as outer, select the contour and contour within as a group.
Then right click to use group sort to distinguish the inner and outer contour.

When adding lead lines, lead line on outer contour cut from outside, that add to

inner contour will start from inside. Click " " in Home menu you can

manually set inner or outer contour.

3.1. 2 Automatic Lead Line

Select the graphic you want to set the lead line, and then click " " under

Home menu, set the parameters in the pop-up window, as shown below:
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Users can add different type of lead line including straight line, arc, straight line
plus arc, and other settings including lead angle, length and radius. You can also add
little circle at lead line start point.

When select lead line as arc type, the end of arc will be tangent with graphic.
The line connects two ends of arc form the angle with graphic boundary. It is the
same with the lead out line.
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Please take notice that executing auto-add lead line will change the previous
setting such as lead position, lead type and the like. You can check "change type, keep
position" to fix the lead line position.

3.1. 3 Manual-Set Lead Line

To change the lead-in line manually, you first click " ", then click on

graphic. The lead-in line position will be changed, the lead length and angle remain
the same.

Click outside the graphic (yellow point), then click back on graphic (red point)
will create a new lead line.

3.1. 4 Check the Lead Line

Click "Lead", and then select"check lead line" to check the legality of the lead
lines that have been set. This function will shorten the lead line that is too long, thus
avoiding crossing with other graphics.Click "identify inner/outer contour" to
determine the specific position of the lead according to the set contour.

3.1. 5 Seal, Over, Gap, and Multi-Cut

There are 4 options " " in technical setting-seal drop down menu.
Select graphic and click function button will take effect. The "gap/over" setting will
not take effect to the graphic already set gap or over.

3.2 Seam Compensation

Select the graphic and then click " "for seam compensation.

Seam compensation width should be got by measuring real cutting result. The
compensation displayed in white on drawing board. Machining will refer
compensation line as tool path. Original graphic still display on drawing board but
not as actual tool path.

The compensation"s inner/outter contour can be set manually or automatically
by follow the rules of "inner shrink, outer expand".

Users can also add fillet on compensation line at corner as shown below:
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In the photo, the line of green is original graphic, white line is compensated path.
It requires smoothing at corner. Usually round corner will smooth the machining path
and assure the consistency of graphic and cutting result.

Users can edit compensation parameter and build a library in compensate
configuration.

To cancel the compensation, select the graphic and click "clear compensation" at
the lower left, or click "Clear" button, choose "clear kerf compensation".

3.3 Micro Joint
Micro joint is to add a small distance joint on the graphic. Laser will not fire on

micro joints. By doing this the parts will not fall from the plate skeleton, also tip-up
collision can be prevented. Micro joint displayed as a breach on the drawing board:

Click" " in technical parameter column to activate the function, then

click on the graphic where need to add micro joint. You can click multiple times to
add more than one micro-joint until press ESC or switch to other command. You can
also click on the compensated line to add micro-joint.

Micro-joint length settingis in the drawing window at the bottom of the software.
New parameters will not change theprevious set micro joints.

CypCutE also has automatic micro joints function. Click "Micro Joint"drop
down menu and select" " will prompt a dialog box for parameter
setting. You can add by micro-joint count, for example, if set 10, each graphic will
add 10 micro-joints; or by distance, set 100 it will add a micro-joint every 100mm
interval.
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Micro-joint will divide the graphic into separate segments. If you want to edit
each segment separately, select "Explode Micro Joint" in drop down menu, so that
each segment is an individual object to edit. You can add lead line on each segment.

To delete a micro joint, select the graphic then click "Clear micro joint" under
"Clear" drop down menu.

When the "Flycut at Micro Joint" in Layer Parameter Settings-Global
Parameters are checked with pierce techniques disabled, the laser head will not lift up
and pass the micro-joint segment without slowing down, which will increase the
machining efficiency.

3.4 Cooling Point
Click " "button then click on the graphic will add a cooling

point. When the machining executes cooling point, it will turn off laser and open gas
maintaining a preset delay, then open laser turn off gas and resume normal machining
again. The cooling point is shown as a solid point white dot in the drawing board as
follows:

Like micro-joint, the cooling point can be clicked continuously to insert more
than one. After you finish setting micro joint and compensation you can still add
cooling point.

CypCutE can also add cooling point automatically. Click "Cooling Point", in
drop down menu select "Auto cooling point" and set parameters in dialog box. There
are two positions users can select to add cooling point automatically: sharp corner
and lead line. The cooling point add on lead line will integrate with lead line. For
example, if click "Clear cooling point" will not delete the cooling point on lead line.
Only delete lead line can remove the cooling point add on lead line.

Press shift and click cooling point you can delete it. If you want to delete cooling
point, click drop down menu of cooling point and select "clear cooling point".

Cooling point is often used in processing workpiece corner, it will pause at
cooling point, turn off laser and gassing to lower the corner temperature to avoid
corner burned.
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3.5 Ring Cut

After selecting the graphic, click " " to create an extra path to improve

sharp corner cutting performance.

3.6 Fillet/Relief

Click " " to transfer sharp corner into rounded corner.

Click " " to create a release notch for bending process.

3.7 Group
Group function in CypCutE means to integrate multiple graphics as a group, or

even multiple groups as a new group. A group will be recognized as an independent
object. The sequence and position of the graphics within a group are all fixed and will
not change by operations on other graphics.
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Select the graphics and click " " to create a group. If you need to disperse a

group, select the group and click " ". To disperse all groups click drop down
menu of group and select "Ungroup All".

"Ungroup" will not disperse the graphics but the group. "Explode" will disperse
the graphics as line segments.

"Joint Path" will create a path connect the group which will reduce the piercing
times and improve the efficiency. Click "Explode Joint Path" will clear the
connecting path.

For a group, if there is one graphic contour contains all other graphics, this
graphic will be defined as outline. The group with outline will be defined as a "part".

It is recommended that CypCutE users create "Group" to integrate a part rather
than grouping graphics randomly. we might use the term "group" with the same
concept as "part".

Please notice that to ensure the integrity of graphics, CypCutE will integrate
co-edge graphics as a group. In addition, use "Bridge" function to connect a group
with other group the result will be a group.

3.7. 1 Group Sorting

The group will be defined as an independent object in sorting. The sequence of
the graphics within a group won"t change in sorting.

If you need to edit sequence of graphics within a group, select a group and right
click, select "group sort".

"Group sort" operation will not change the sequence of graphics in sub-group. It
will distinguish inner and outer contour of graphics within a group by geometrical
relations.

3.7. 2 Group Processing

Group will be defined as an independent object despite whether it contains
multiple layers inside, until a group is fully processed it will not move on to the next
graphic. Piercing of group follows the same rule.

Please take notice that the outmost contour of a part/group will always be
processed at last.
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3.8 Fly Cut
When the graphics are standard shapes like rectangle, circle or polygon and

layout in principles, you can use fly cut function to improve the machining efficiency.
Before use flying cut, execute sorting first, this will optimize the cutting path.

3.8. 1 Linear FlyCut

Click drop down menu of " " to select flying cut patterns and set parameters.

Start position defines where to start fly cut. Valid distance: fly cut path to turn around can be

created if the distance is shorter than the set value. Tolerance: fly cut path to turn around can be

created if longitudinal distance between two lines shorter than the set value

3.8. 2 Circular FlyCut

When the graphics in a layout are all circles, directly click "FlyCut" button, or
select "Circle FlyCut" pattern in the drop down menu.
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Max distance between two circles means only the distance between two circles
shorter than this value can create fly cut path.

Select "Sort circles" will execute sorting before flycutting; if select with "Flycut
by part", it will process the graphics within a group then process next group.

Select "Sort circles" only, it will execute sorting then create fly cut path.

3.8. 3 Obround FlyCut

Obround flycut is for generating flycut path for rounded rectangle and
obround-shaped graphics.

Select "Keep Micro Joint" when using Circular FlyCut and Obround FlyCut, the
micro joints added before will not be cleared.
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3.8. 4 One Path Fly Cut

One Path Fly Cut is for generating fly cut path for irregular graphics.

"Max radius": the radius of direction-changing circle, 3mm recommended.
"Groups": auto grid group when sorting intense inner holes.
"Max FlyCut": the fly cut path can be generated when the distance between two

graphics shorter than set value.
"FlyCut by part": only generate fly cut path inside graphics when select the

option.
"FlyCut LeadIn": it is supportable to set lead line before generating fly cut

path in one path fly cut mode. Select "Allow leadlines change" to allow change the
start point position to generate more fly cut path.

"Original order": select the option so it will not sort automatically when
generating fly cut path. Only selected when you need to keep inner contour order.
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3.9 Co-edge
Merge the shared line of two parts as one will

reduce the cutting length. In CypCutE, the distance of
parts smaller than 1mm can use co-edge function.
CypCutE provides graphic snap function to snap two
graphics and merge the shared lines.

Select the graphics and click " ", CypCutE
will merge the shared lines of the selected graphics.
The Draw bar down below will give hint when the
graphics selected cannot be co-edged.

CypCutE cannot merge the inward concave lines
of the graphics.

The graphics merged shared lines will be
integrated as a group. If the graphics which are going
to merge the shared lines contains other graphics inside like circles, you have to
group the graphics first.

3.9. 1 Automatic Snap

When you drag the graphic,
it will snap to another graphic
automatically as the graphic
dragged into the position fit for
co-edge. Snap function will help
you quick adjust the position of
graphics fit for co-edge.

Once graphics attach with
each other with shared lines, click
"Co-edge" will create the co-edge
line. If you want to disperse the
graphics with co-edge, or sort them, click "DeGroup"", and recombine them after
editing by "Group".



38/74 Friendess CypCutE Laser Cutting Control Software

3.9. 2 Co-edge with Compensation

If you want to add cutting seam compensation to the graphics, you have to add
compensation first then execute co-edge. Otherwise, the co-edge line will not remain.

For example, in the above picture, graphic P is the compensation line of the
graphic A, only graphic P can co-edge with graphic B because graphic A is not real
cutting path.

3.10 Bridge
When a workpiece contains several parts and you want to keep them connected

after processed, you can add bridge between graphics. And graphics with bridge also
reduce the pierce times. Several bridge line can realize "one-path" cutting.

To bridge two graphics, click " " and drag a line segment on the drawing
board, the graphics crossed with the line segment will be bridged like below.

Bridging requires specifying the bridge width.
After adding bridge the graphics will be recognized as group, a single graphic

may not be completed until the whole group is done, so please be careful that the
continuous cutting will cause heat affect to cutting quality.
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3.11Array
The "Array" function is used to quickly duplicate a graphic. There are 4 patterns

of Array in CypCutE.

3.11. 1 Rectangular Array

Click " " or "Rectangular Array" in the" Array "drop-down menu will
prompt the parameter interface below:

Set the rows, columns array layout and row direction of the array to duplicate
the selected graphic:

3.11. 2 Dynamic Array

Select the graphic and click "Dynamic Array", set the row space and the column
space, drag the cursor will have the selected graphic duplicated.
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3.11. 3 Polar Array

Select the graphic and click "Polar Array" to set the parameters, then click at a
position where would be the center of the array circle, the graphic will be duplicated
as you click.

3.11. 4 Fill

This pattern is used to duplicate the graphic to cover the whole plate by pre-set
plate dimension and nest parameters.
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3.12 CutOff Line
CutOff line can completely identify irregular remnant when jog cut or quick

cutoff cannot.

Selecting the curve, click " " to set it as a cutoff line, which will be cut at

last by default. When using the cutoff function, check whether the technical
parameters are set correctly. The remnant path in CypNest will be automatically set as
cutoff line as imported into CypCutE. As shown below, the cutoff line shown in
yellow and marked with a "knife".

In CutOff drop-down menu, you can cancel cut-off line setting.
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3.13 Generate Border Contour
To generate border line along the contour of graphics (purple line below). The

function is for checking whether the graphics to be cut on irregular plate was out of
range.

Parts distance: Parts of space within valid distance will be in the same border contour.
The smaller the value is, the less parts will be contoured. It is recommended to set
the distance longer than the actual one.

Expand border: the smaller the value, the less border line expand.
Smooth border: the smaller the value, the closer border line to the graphic.
Clear border contour in the drop-down menu.

3.14 Measure
CypCutE provides two types of measurement: line measure and curve length

measure.
Line measure is for measure the distance between two points, giving the details of

length, angle, position on x and y axis.
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Curve length measure is for measure length of poly line, shown as the yellow line
below.

3.15 Batch Modify
To edit a graphic and apply the result to all graphics of the same shape, you can

use quantity modify.
Select the graphic and click "Batch Modify" in Home, drop-down menu of

Select. For instance, you set lead line to the graphic, it will apply to those the same
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with this one.
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3.16 Technical Parameters
There are 17 layers in CypCutE, every layer can be set parameters separately

including cutting speed, laser power, gas pressure and nozzle height etc. The last two
layers are "process at first" and "process at last"

Click "Layer" , in Home menu will open layer parameter setting window
containing almost all parameters related with machining. The first page is "Global
parameters", for setting default parameters used universally in machining. The other
pages list all the layers applied. Click the layer page to set the parameter of this layer.

Notice: The parameter options may differ among different laser sources, gas
configuration, and height controller. The parameter in image above is for reference
only, users must set the parameters according to actual machine condition.
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3.16. 1 Parametric Description

The following table gives a brief description of some parameters in the layer.
1 Basic Parameters

Cutting speed Set the target speed of actual cutting. Because of the acceleration

and deceleration in machining workpiece corner, the actual cutting speed

is usually slower than the set value.

2 Machining mode

Standard Machining will follow the preset parameters.

Fixed height cutting Laser head will be at a fixed height in whole cutting process.

Out-plate following Select this mode, the laser head will start outside from the plate at the

reference height, and follow to cut height once move into the plate.

Set "Reference height" by locating the head to proper height, and then

through CNC- BCS100-Save out-plate reference height to save

parameter.

3 Machining parameters

Nozzle height Set the following distance between nozzle and plate.

Gas type Set the type of auxiliary gas used in cutting.

Gas pressure Set the gas pressure of auxiliary gas in cutting, this requires

proportional valve.

Peak power Set the peak power of the fiber laser. Peak power determines the

maximum cutting power that the machine can achieve. For a 3000W

cutting machine, if the peak current is set to 80%, the maximum cutting

power is 3000W * 80% = 2400W.

Duty cycle Set the PWM duty cycle used in machining.

Pulse frequency The frequency of the PWM modulation signal which is the times of

laser fires within 1 second.

Focus position The distance between the focus and the nozzle tip of the cutting

head is used to define the focus position.

Laser ON delay The duration of laser firing to ensure the workpiece pierced through.

Laser OFF delay A delay used to ensure complete cutting before turning off the laser.

Gas blow After finish piercing, turn off laser and turn on gas to cool down the

material.

4 Other parameters

Not cut This layer will not be cut.

Not follow This layer will be cut without BCS100 following.

Blow Keep the gas on during cutting.

Pre-pierce It will pierce at all graphics start point or lead line then start cutting.
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In "Global parameters" window there is "group pre-piercing", enable this

function it will execute pierce of one group and complete machining of

this group then move to next one. Notice: pre-pierce cannot be selected

with Defilm.

Defilm It will execute filming parameters along the graphics then start

cutting. After you select this option there will show a Defilm layer page.

Recool After finishing machining a graphic, turn off laser but blowing gas

along the graphic to cool down the material to reduce the heat effect on

the workpiece precision. After you select this option it will show a

Recool layer page.

5 Slow Start

Start Length Set the cutting distance after the starting point of the contour.

Start Speed Set the cutting speed of the start length.

6 Slow Stop

Stop Distance Set the cutting distance before the end point of the contour.

Stop Speed Set the cutting speed of the stop distance.

7 Power curve

Real-time

power/frequency

regulate

You can customize the power/frequency curve. The software will

regulate the laser power (duty cycle of PWM signal) and frequency in

real time according to the curve, which is of great help to optimize the

cutting quality of corners. Note: frequency curve cannot be selected

alone.

8 Enable precision

Enable precision When precision mode is enabled, low-pass frequency, cutting

acceleration, curve precision and corner precision can be set for

individual layers.The smaller the low-pass frequency value is, the

smaller the impact on the machine tool will be.The smaller the values

of curve precision and corner precision are, the higher the machining

precision will be.

9 Smooth Pierce

Smooth Pierce Smooth pierce is suitable for medium and thin plate cutting,

ensuring high efficiency while extending lifespan of protective lens.

10 Vibration suppression

Vibration suppression Self mode vibration suppression is recommended,the system will

automatically execute suppression according to cutting technical

parameters.
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3.16. 2 Real-time Power/Frequency Curve Regulate

If you select " ", the laser duty cycle and

frequency will regulate with speed in real time. You can click the" "to edit

the power/frequency curve.

As shown in the photo above, horizontal axis is speed, vertical axis is
power/frequency, unit is percentage. You can select the curve pattern and set the
power level when machine reaches a specified speed. Or you can click

" "copy the power curve to frequency curve. Notice: Only when

"Power curve" is enabled, "Frequency curve" can take effect.
For example, laser power 500W, cutting speed 100mm/s, peak power 90%, cut

power 80%, when the actual speed slow down to 45mm/s, the laser power is:
500W X 90% X 80% X 75.00% = 284.4W
The power will not be lower than the preset value, which often is 10% of the

laser power, for example 500W laser will not lower than 500*10%=50W.
If is " "not selected, the cut power will remain not

change in cutting process. In the above example, if not select these two options, the
power in the cutting process is 500 W X 90% X 80% = 360W.

3.16. 3 Layer Mapping

Click "Layer" drop down menu users can lock or display a specified layer by
selecting options. When there are more than one layers as importing DXF file, click
"layer mapping" it will distinguish layers. Shown as below:
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3.16. 4 Lead Line Technique

When cutting thick plate of stainless steel will generate plasma cloud which will
absorb laser energy and reduce cutting energy, gas can hardly blow off the plasma
cloud at cut height. Lead line technique is applied to solve this issue. After execute
pierce, laser head will stay at a higher position and blow off the plasma cloud, then
slow the speed in horizontal direction to make up the pressure loss, and to ensure plate
cut through.

When cutting thick plate you can set lead line technique including speed, power,
lead height and stable distance.

The lead line operational description:
1. Pierce at start point of lead line;
2. Laser head lifts to the lead height to blow off plasma cloud;
3. Laser head descent to the cut height and cut at "lead speed" in the length of

"stable distance";
4. After cutting out of the stable distance it will start normal cutting.
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3.17 Nest
Nest function is used to layout the parts in a plate with highest utilization. Users

can click nest button to finish nesting. CypCutE also provides options to customize
the nesting like: Parts gap, plate margin, rotation angle, co-edge etc. You can find nest

function button " in Home menu-Nest drop down menu.

3.17. 1 Nesting Details

In nesting operation there will be a side bar at left screen to display the parts,
plate and nested plate.



52/74 Friendess CypCutE Laser Cutting Control Software

Parts library will list all parts, you can add new parts by right click at parts lib
and select "load parts", or you can select parts at drawing board right click the part
select "add to parts lib". The parts type limits is 50. Right click at side bar you can
choose to import standard part, delete part or save un-nested parts.

Plate library lists the plate type and plate quantity, you can add new plate using
the same operation with adding parts. Right click side bar you can choose to delete
plate or save as file.

Nest plate lists all nested plates and already processed plates. CypCutE now only
supports 20 plates nesting at one time.

Users need to set basic parameters for nesting. "Part gap" is the minimum space
between parts; "Plate margin" is the plate margin left when nesting; "Nest strategy"
only supports array in CypCutE.
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In "detail settings" you can set parts rotation angle, nest direction, and co-edge
etc,.

3.17. 2 Nesting Report

In "Nest plate" list right click the plate select "Nesting information" and finish
the setting about pricing then click "generate report", it will prompt layer window, the
layer parameters used to estimate the cost. After set up will shown as below:
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3.17. 3 Automatic File Switch

Open nrp or nrp2 (file package generated by CypNest nesting software), it will
list all nested plates, also processed times and planned process times. The processed
times will add up after the current plate task machining finished. When the processed
times reach to the planned times it will automatically switch to the next file.
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3.18 Sorting and Path Planning
The below function column is in the "Draw" menu which list all sort patterns

and align tools.

You can find details on group function in "Group". If no special requirement to
the sorting result, "grid sort" is recommended.

3.18. 1 Sequence Preview

Drag the progress bar or click" "you can preview the machining sequence

of the graphic. Below picture shows graphic status when preview sequence:
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Sequence preview is completely interactive, making it easier to control the
progress forward or backward,or zooming the graphics. You can view the move path

to check the overall sequence by opening "View" drop down menu and select .

3.18. 2 Manual Sorting

If you want to adjust sorting result, you can manually edit the graphic sequence. Select

graphics then click" ",the buttons from left to right are:

Move Front The selected graphic will be the first to process.

Move Last The selected graphic will be the last to process.

Move Prior Adjust the sequence of the selected graphic one step forward.

Move Next Adjust the sequence of the selected graphic one step backward.

Notice: all sequence types only take effect inside the graphic. Sequences among
layers can be changed in Layer Parameter Settings.

After sorting, click " "to check the sequence one by one.

You can also open "Manual sort mode" to edit the sequence. Click " " on left

bar of main screen will enter "manual sort" mode. It will display the graphic sequence
and path. Click graphic one by one as you required. If one graphic was clicked
accidentally, click this graphic again or right click to cancel the operation. If you just
want to edit the sequence between two graphics, just click on one graphic drag a red
line to the other will set the new sequence of these two.
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3.18. 3 Smart Sorting

When the smart sorting is enabled, it will automatically set grid pattern on the
graphic, and generate cutting sequence with shortest travel distance. As shown below,
the white area is the automatically set grid area, and the green line is the sequence
path.

3.18. 4 Group Sorting

If you want to fix the sequence of certain graphics, you can group these graphics.
The sequence of the graphic within a group will not change in other sort operation.
When process the graphics within a group, it will not process other graphics doesn"t
belong this group till the group is finished.

If you only want to sort certain graphics, group these graphics and use "group
sort" function. Select graphics and click "group", then right click on the group - select
"group sort".
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4. Machining Control
CypCutE integrates CAD and CAM functions, all operations including edit file

and set cutting parameters can be done in the office or on your own computer. Then
you can open the file on machine for processing directly.

4.1 Coordinate System
Modeling coordinate designing graphic not relevant with the machine, zero point

marked by " ". The coordinate referred in machining process and machine position

are shown below:

Click the " in console will display the laser head position correspond

with graphic.

4.1. 1 Mechanical Coordinate System

Mechanical coordinate of the machine is defined by the mechanism. Coordinate

system is consistent every time execute return origin " ". Misalignment
appeared after installation or caused by exception can also be reset by clicking it.
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CypCutE defines coordinates with same rules no matter applied on what
mechanism . Stand in front of the laser head, laser head towards right is X+ direction,
towards back is Y+ direction which means the left bottom is the minimum coordinate.

4.1. 2 Program Coordinate System

Mechanical coordinate is consistent, CypCutE also adopts workpiece coordinate.
Workpiece coordinate X/Y direction are the same with the mechanical coordinate
system, only 0 point is different and is called program 0 point. Program coordinate
system is divided into floating coordinate system and workpiece coordinate system.

Click the button above the console panel you can select "Floating coordinate", 9
"Workpiece coordinate" or "external coordinate".

Floating coordinates used in cutting samples or small quantity parts. Laser head
will start machining from current position. The current position of the cutting head is
automatically set as 0 point when user executes "Frame", "Dry run", or "Start".

If select workpiece coordinate 1-9, the zero point is manually set by users, and
will only be changed by manual reset. Workpiece coordinate applied for large
quantity production. This will assure the next time machining starts from same
position on the machine every time.

Click the bottom status bar "

You can select to display mechanical coordinate or program coordinate and
specify the zero point of the coordinate. Select "coordinate positioning" will locate
the cutting head to the specified coordinate position.

4.1. 3 Find Zero Point after Interruption

Situation 1
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If machining process stopped by the accident but not affect coordinates, you can

click " ", return to zero point.
Situation 2

If accidents like power down or servo alarm stop the machining process and
deviate the coordinates, must execute return origin then click "" locate to zero point.
If accidents like power down or servo alarm stop the machining process and deviate

the coordinates, must execute return origin then click " " locate to zero
point.

Situation 3
If the machining process interrupted by the accident or misoperation, you can

still locate to the zero point of last machining process.
Select "Mark zero" from the drop-down menu of Mark in the console, and then

click "Go Mark".

4.2 Alarm
CypCutE monitors all components when machine running. Once an alarm was

monitored, it will stop the machining and display the alarm message in red title.
Motion function will be disabled until the alarm removed. Check the alarm source
and remove the alarm then resume the machining. The alarm title shown as below:

The "Alarm" window at the screen bottom also display the alarm message. After
remove the alarm source the alarm title will disappear but alarm message in alarm
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window is recorded. Double click "System" window can check all history records and
software events.

Besides alarm CypCutE will display the warning, notice and important message
in different color once monitored abnormal process. These message will not stop the
machining but still suggest noticing these information and taking precautions.

Below are restrictions once alarm activated:
Disable servo when emergency stop alarm activated (prevent accident
motion)
Disable X/Y motion functions when BCS100 alarm detected (under this
status, Z axis condition unknown, there might be collision if X/Y move)
Disable XYZ motion function when emergency stop alarm activated (in
complete stop status)
Z limit- alarm, disable dry run and jog.

4.3 Manual Test
The function buttons in console panel as shown below:

The button " " will be in" " once the function activated. Press " "
will emit laser, release button will close laser; for other buttons, click the button

activate the function, click again close the function. For example, click " "
open the gas, click again close gas. For different laser model, there will be a delay
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when click " " before it turns to " ". This status is accessed from laser

unit. Click " " will open guide/pilot laser.
Please take notice that function can only be realized with related machine

components on place. No hardware detected or settings not correct in configuration
tool, the function button might not work.

Click " " to mark the current position, click " "if you
need to locate to the mark position. Users can record 6 marks in total select in

" ".

4.4 Soft Limit Protection
CypCutE provides software limit function. You can enable this function

" " in Global parameters. The feature is default on.

When the system detect motion area will exceed the preset limit, it will prompt
message box to warn users and stop sending motion command to prevent collision.
Check the graphic on the drawing board to make sure it"s within the white frame.

System will monitor the current position in real time and stop the motor function
once detected exceed the soft limit.

Notice: Soft limit protection relies on correct coordinates. Therefore, every time
after change the machine configuration or system abnormal shut down happens, users
must execute return origin to correct coordinates.

4.5 Frame

Click " " laser head will move along the outline of the workpiece in
a rectangle frame to help users identify the machining position and workpiece
dimension on the plate. Frame speed is set in "Layer-global parameters-frame speed".

Notice: If the plate not up-right put on the machine bed and executed seek-edge
operation, frame direction is also not up-right.

4.6 Start and Dry Run

Click " " start machining, there will be monitor of machining process
like coordinates, speed, time count and following height etc.
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When in above status you cannot switch to other pages except File menu, for
preventing graphics modified by mistake when machining. You can pause the
machining to modify parameters, and it will take effect once machining resumed. If
you modify without pausing the machining, the setting will take effect on the next
one.

Click the " " laser head will move along the actual cutting path with
same speed and acceleration but laser, gas and follow function turning off.
Meanwhile other functions like pause, resume, forward, backward and break point
information all same with the actual cutting. Dry run can used to check the machining
process without cutting the plate.

By default setting, laser head will return to zero point after finish machining. If
you want laser head return to a specified position you can set on console panel
including zero point, start point, end point, origin and mark point.

If " "not selected, laser head will stand still at where finish

the machining. If you want laser head return to a mark point, select "process ends, go
to"+position you want.

After a machining process completed it will add up 1 on "Finished" at console
panel. When the "Finished" reach the "Total" times it will prompt message to remind

users. You can set target machining times and laser head actions in " "

after machining process completed. If you need to cycle the machining, click

" " and finish the setting.

4.7 Stop, Pause and Continue

To stop machining, click " " or " " button on the console.
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Click " or " " on console panel can pause the machining

process. Meanwhile you can modify the parameters in layer window, or execute the
functions in console panel like burst laser, gas, turn on/off follow function etc.

Click " " or " " button on the console to resume the

machining process from interrupted position. Click " " will resume the
machining process directly without piercing.

Click " " or " "to locate laser head backward or forward
on the machining path. The distance and speed of one step set on

" " at control panel.

4.8 Breakpoint
When the machining process interrupted by accident like power down, as long

as graphics and parameters related with machining process and sequence not been

changed you can click " " to locate to the break point. Click

" ", program will resume machining from break point.
If you change the machining parameters, the "Start" button will turn into

" ", under this status break point function will be not available.

4.9 Start at Specified Position
CypCutE allow users start machining from any position of the graphic. Right

click on the graphic where you want to start machining and select "Start from here".
As shown below:
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For safety concern, select "Start from here", program will prompt dialog box to
ask users to confirm operation. Then laser head will locate to the specified position,
and start machining. The path before specified position will not be machined.

If you select "Locate here", laser head will locate to specified position then come
in pause status.

You can execute "Locate here" multiple times. until you are sure. Or you can

adjust start position by " " and " ".

4.10 Global Parameters
The parameters setting in "Global Parameters" window will affect the machine

running condition, cutting performance and efficiency.
Below table lists part of the parameters.

Motion Control Parameters

Travel speed Dry run speed (different from cutting speed).

Travel acceleration The max acceleration axis can reach in dry run.

Travel low-pass

frequency

The acceleration jerk of travel acceleration.

Frame speed Speed of frame-walk the workpiece outline.

Cutting acceleration The max speed axis can reach in cutting.

Cutting low-pass

frequency

The acceleration jerk of cutting acceleration.

Jog acceleration The max speed axis can reach in jogging.

Jog low-pass frequency The acceleration jerk of jogging acceleration.

Corner acceleration The acceleration of corner commutation.

Curve precision The smaller the value, the higher the machining accuracy of curve.

Corner precision The smaller the value, the higher the machining accuracy of corners.
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Default Settings

Gas on delay Blowing delay before cutting.

First gas-on delay Extra delay when first time open gas after start-up the machine.

Pre gas on Time of opening gas when travel

Gas switch delay The time required to make sure old gas totally discharged and new gas

comes in when switch the gas.

Cooling delay The time of blowing gas at cooling point.

System delay Delay of servo response.

Resume, stepback When resume the machining process from pause status, laser head will

move back a distance.

Gas parameters

Gas pressure Gas pressure when performing blowing.

Gas on Lasting time of a single blowing.

Interval Gas-off time in the whole gas operation.

Start, Gas On Blowing times at the beginning of processing.

Resume, Gas On Blowing times when resuming processing.

Follow Control Parameters

Lift height Maximum height of Z axis frog jumping.

Max follow height There is limit of follow distance between nozzle and plate surface. If

the follow height larger than this value, Z axis will follow to this height

then lift up to the target height. This parameter is used to set the

maximum follow distance between nozzle and plate surface.

Frog leap lift Z axis moves in time-saving frog-jump style.

Smart Frog leap Automatically adjust the leap height according to the tip-up angle of

parts.

Frog-leap start height Lift to the set height before execute frog leap.

Max Frog leap down Y axis value of Frog leap parabola vertex.

Short distance no lift If in layer setting select "Short distance no lift", when the dry run

distance shorter than this value, Z axis will not lift and stay at cut

height.

Hold fixed height Applied in nun-metal material cutting, select this option it will disable

follow function in machining.

Smart follow Short-distance travel does not perform plate detection.

Advanced

Hide crucial settings Hide some parameters which will affect the machine service life if set

improperly.

FlyCut at MicroJoint No pause at micro joint with fly cutting, invalid when pierce techniques

enabled.
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Technique check Check whether the default machining parameters are valid.

Thickness check Check whether the material thickness information is set in the layer

parameter setting.

Quick Find Edge Shorten the process of finding edge.

Edit PLC Process PLC process editing.

Pierce Defilm Set the sequence of defilm and pierce.

FlyCut overcut Over fly cut distance to ensure part entirely cut.

Extended cutoff length Overcut distance on cutting cutoff Line.

GasOn protection Select "Blow" in layer settings, and set gas pressure here.

Unit Select the unit of the parameter according to your habits.
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5. CNCAssistant Function

5.1 Simulation
Users can simulate the cutting process check the cutting sequence in program.

This process executed only in software, not sending any commands to the machine.
By simulating the machining, users can check the sequence between parts and in
parts.

Click the " "in control panel, it will switch to "CNC" menu
automatically, you can adjust simulating speed in tool bar.

5.2 Find Edge
CypCutE supports two patterns to find plate edge: BCS100 find edge and

manual locate edge. Click "Find Edge" drop down menu you can select the find-edge
pattern to locate plate position and edge. Find edge result will be displayed on the top
right area of drawing board.

Click " " under CNC or click" Capacitive Find Edge"to open BCS100 find
edge parameter window.

Plate size X is the plate length in machine X direction; plate size Y is the plate
length in machine Y direction. The 2nd and 3rd point position to locate the plate edge
is calculated by the plate dimension,it"s suggested that input value little smaller
than actual dimension to avoid laser head crash in machine teeth.

Margin: Find edge result will determine a 0 point of plate. This margin can
adjust the 0 point inward or outward the plate. If you have set plate margin in nesting
plate then you can input 0 here.

Identify sheet dimension: automatically set plate dimension according to the
border of graphic.
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6-point find edge: This recommended to use on thin plate. Laser head will
execute 6 times find edge actions to reduce the interference of machine teeth.

Start from preset position-you can set a fixed position then find edge will start
from this position every time. You can locate the laser head at a fit position as start
point to find edge. This position must be within the plate.

Start from current position-laser head will start to find edge from current
position. Please make sure laser head is within the plate.

If select "find edge before machining", it will execute find edge before start
machining.

Notice: Before execute find edge function, make sure laser head can follow to
the material properly. The inclination angle of the plate should not exceed 10 degrees.

Find edge parameter window shown as below.

You can also set more detailed actions by clicking "Detail settings" at the left
bottom.
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Find edge speed affects the accuracy of result, recommended 100mm/s；
Find edge height is distance between nozzle and plate in find edge process,

recommended 4mm；

Prong Dif is the gab between machine teeth tip;
2-point distance and 2-Pt Dis(short side) decide position of the other two

points.

5.3 Quick CutOff
Quick CutOff is used to quick cut the remnant off.
Thin sheet CutOff: When checked, CutOff safe distance will take effect.
CutOff safe distance: Laser head starts from outside plate in a fixed height after

pass this distance will follow to plate.

X CutOff (Left to Right): Select this option when execute split-plate function,
laser head will follow out of the plate then cut in from left side, then follow out of the
plate cut in from right side.

Notice: When split plate it should use parameter of green layer.

5.4 PLC Process

Click " "in "CNC" menu users can edit and execute PLC process.
Notice: Inappropriate PLC settings can lead to serious consequences! Please

contact our technicians if you have any doubt.
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5.5 Task
If an urgent task cuts in line while the current task unfinished, use Task function

to save the progress including program zero point, find edge angle, breakpoint, and
file. After finishing the urgent one, you can re-import the last task, then go the
breakpoint and resume the machining.

5.6 Return Origin Point

You can click " " in CNC menu to return axes to mechanical origin and
rebuild coordinate. See details in section "coordinates". Select "X Only" or "Y
Only"axis will return origin separately. If you select "Z axis first" or "Auto-focus
included"program will execute the actions when return axes to origin.

5.7 Path
In the machining, if you need to position the cutting head to a certain point, you

can click " " in CNC menu, enter the specific coordinates you want in box

shown on the right " ".

You can also set the laser interferometer parameters in this interface to test the
error between the position in software and the actual position on machine, so as to
compensate the mechanical error, also known as pitch compensation.

5.8 Calibrate
Support manual and one-click calibration.
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5.9 Shortcut key
The following table lists the shortcuts commonly used in CypCutE, some of

which need to be used in specific circumstances.
Shortcut key Effect Using conditions

Ctrl + A Select all graphics None

Ctrl + C Copy graphics to the clipboard Select the graphics to operate on

Ctrl + Shift + C Specify baseline copy command Select the graphics to operate on

Ctrl + O Open a file None

Ctrl + P Show/hide graphic direction and move path None

Ctrl + V Paste clipboard graphics to drawing board There are copied graphics in the

clipboard

Ctrl + W Adapt the window None

Ctrl + X Cut graphics to Windows Clipboard Select the graphics to operate on

Ctrl + Y Redo the command you just revoked There are revoked orders

Ctrl + Z Revoke the order just completed There are completed commands

F2 Open the Layer Parameter Settings

window

None

F3 View all graphics None

F4 View the whole machine tool range None

F7 Show/hide machining path None

F8 Show/Hide move path None

DEL (Delete) Delete selected graphics Select the graphics to operate on

SPACE (space) Repeat the previous command The previous command is

repeatable
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